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According to 2006 CHAOS Research, a study of 10,000
global software projects completed between October
2005 and November 2006, reveals that only 35% 

were delivered on time, on budget, and within stated
requirements1.That’s a significant improvement over the 1994
CHAOS report2 where it was reported that only 9% of IT
projects came in on-time and on-budget. Even when these
projects were completed, many were no more than a mere
shadow of their original specification requirements.

That news should be a major concern however, as the remaining
software projects were either challenged or considered failures.
If 65% of projects failed in other disciplines - healthcare,
manufacturing, or construction for example - that would just
not be acceptable. IT professionals have only recently started to
embrace a formal Project Management discipline and are now
starting to see some positive results from that investment.

Growing Interest in PM Methodology and Credentials

The Project Management Institute (PMI)3 has become the leading
organization for the advancement and success of the discipline of
Project Management globally. PMI offers several certifications4

including the Project Management Professional (PMP). PMI Today5

reports that there are currently 233,330 active, certified PMPs. 

A PMP credential is a great differentiator in today’s competitive
job market. The question that remains, however, is whether it is
sufficient to manage today’s projects, given complex work
breakdown structures, enterprise-wide resource management
challenges, and sophisticated schedules. Add to that a mix of
global project teams, who need to report project performance
data to Senior Management, and suddenly, the need for
additional expertise becomes quite apparent.

Microsoft Office Project 2007 Certification Program

Certifications are a proven way to validate your knowledge and
expertise, not only to yourself, but also to your colleagues and
your management. Rising corporate IT spending is leading to
increased demand for workers with certifications in information
security, project management and related disciplines. In fact,
Project Management skills are especially vital to organizational
senior leadership. A recent study showed that 23% of CIOs
ranked project management as the area in which their IT staffs
could most use improvement6. 

Given the latest release of Office Project 2007 and the growing
demand for a credible way to demonstrate expertise with this
proven project management application, Microsoft is pleased to
announce the newest certification family for Office Project 2007
and Office Project Server 2007. Microsoft certifications
represent the mark of tool utilization expertise and offers
increased breadth of knowledge, increased opportunities on the
job, and increased value to the organization.

More than a product certification, the new Office Project 2007
certification suite is designed specifically to help project
managers, in all types of business environments, apply the
leading project management best practices and methodologies
as established by PMI. The result? Project Managers now have a
thorough understanding of how to establish and maintain
project schedules, resulting in better project outcomes, greater
efficiency, and optimal resource management. 

Before highlighting how these Office Project 2007 certifications
can benefit Project Managers, it is worthwhile to consider some
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“Microsoft recognizes MPA as the leading industry
association helping project managers and organizations
get the maximum value out of Microsoft Office Project.
With its different avenues to interact and network and
resources on Microsoft Office Project, MPA is playing a
pivotal role in helping project managers and organizations
learn from each other and maximize the success of their
projects using Project. We strongly believe that any
individual managing projects would benefit immensely
from being part of this association.”

Michael Angiulo, General Manager
Microsoft® Office Project, Microsoft Corporation

The evolution of project management
is well underway. As Microsoft
unveils the certification programs

now available to all customers, it is evident
that these credentials will play an important
role in the professional development of this
discipline. Doc Dochtermann and Marie
Mihail, emphasize this in our issue’s lead
article. Supported by research and based on fundamentals of
sound project management practice, the Microsoft suite of
credentials will provide a measurable competency that can assist
both the employee and employer in improved performance. 
More information on certification will be available at the 
Microsoft Project Conference slated for October 29 – 31, in 
Seattle, Washington. 

This special expanded edition of the Project Newsletter also
covers a broad range of other topics that the professional
practitioner will find valuable. Pcubed, one of our founding
sponsors, was the recipient of the 2007 Microsoft EPM Partner
of the Year Award. In this issue, they share with us the “secrets”
of the Earned Value Management Solution. Our regular feature
“Ask Brian” raises interesting points in “Iterative Design/Build
Loops in the Configuration of Project Server” by Brian
Kennemer. MPA then went out to discuss some interesting buzz
on the street in an interview with Dan Renier as we learned more
about “YJTJ™”. Some helpful tips were provided by Genea
Mallow-Jensen in “Working in Customized Project Assignment
Views”; Bonnie Biafore in “Send Your Tracking Change Requests
in Project” and by Ira Brown in “Got to Get you Into My List”.
John Reinheimer makes a special offer to MPA members with a
working copy of his “Project Plan Analysis”, available by request.
Al Callan raves about the WBS Chart Pro while Michael
Steinberg offers new Project users “Top Ten” (actually 12) Tips.
Last but not least Nicholas Pisano begins a three-part series
addressing the “Building Blocks to an EPM Solution”.

Our diverse views and needs are highlighted by this wide range
of topics and discussions. MPA strives to offer unique
information for every level user of Microsoft Office Project,
which is in fact, the fundamental structure of the MPA
philosophy. MPA offers networks of information access, available
through content and contact, to impact your performance. We
hope that we have achieved our goal with this expanded edition.
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To maximize the learning
experience, we recommend
that you have a good
understanding of key project
management concepts and
terminology (i.e. PMBOK).
In terms of how these
certifications can help you in
different types of project
management capacities, the

following section outlines the key topics, skills and roles. 

• The MCTS: Managing Projects with Microsoft Office Project
2007 certification validates the skills of a project manager
who uses Office Project 2007. This individual may work on
projects as a team member, project lead, project manager,
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common market perceptions around Project Management, both
the “Myths” and “Truths”:

Certification - Continued from page one showcase your commitment to the project management discipline
and further differentiate yourself as a proven project manager.

The Office Project 2007 certifications are designed to support
both the Desktop and Enterprise Project Management (EPM)
business environments. This ensures that whatever your project
management responsibilities cover, the Office Project 2007
certification family includes a perfect option for your learning
needs. This chart illustrates the three certifications, the
associated exams and training courses, and how these Microsoft
Office Project 2007 certifications align to and complement the
PMBOK methodologies.

Initial feedback from 
the Project Management
community has been
enthusiastic about the
opportunity to validate
project management
expertise with Office
Project 2007. How do
these certifications really

impact a professional working in a project manager role? By
learning how to maximize your usage of Office Project 2007 as the
project management application, you will build your project
management skills and competency so that you are now in control
of the project.

A commonly asked question about these new Microsoft Office
Project 2007 certifications centers upon whether the certifications
are really about Project Management methodologies or about
validating expertise with the management of Project Management
tools. The new Office Project 2007 certifications focus on
leveraging Office Project 2007 as the Project Management tool.
However, they are also designed to complement the PMI® Project
Management Body of Knowledge (PMBOK) methodology.
Achieving Office Project 2007 certifications are a perfect way to

Continued on page thirteen
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Pcubed Perspective

Elements of EVM have been in practice since the turn of 
the century. In the 1960’s, the U.S. Department of 
Defense established the Cost/Schedule Control 

Systems Criteria (C/SCSC) as a financial control methodology,
which has evolved into a more streamlined project management
methodology known today as EVM. This practice has become
widely used and boasts a direct correlation between the use of
EVM methodologies and program/project success. In many
cases, EVM is mandated for certain federal agencies 
and government programs and projects. In addition, many
private companies have adopted EVM as a means to 
comply with the increased accountability brought forth by the
Sarbanes-Oxley Act of 2002. 

Many organizations practice some form of rigor in planning,
executing, controlling, and measuring performance on their
programs or projects. The most common practice followed is the
comparison of actual cost and schedule performance to the
planned or budgeted cost expenditures and estimated timelines
for accomplishing the scope objectives of the project. What
typical project monitoring and control does not adequately
measure, is the amount of actual scope that has been
accomplished or “earned” in relation to the budgeted and actual
cost and schedule. In other words, cost and/or schedule status
may not always reflect the true picture of actual work
accomplished, which is frequently a subjective determination. 

So what is EVM and what makes this different from the typical
project controlling and monitoring? EVM is an advanced means
of objectively measuring the true health of a program or projects
technical (scope), cost, and schedule condition and provides the
ability to better forecast the outcome of the program or project.
EVM’s underlying foundation is the processes and
methodologies used to achieve a more structured and
disciplined approach for:

• Improving scope definition

• Limiting scope increase

• Measuring and reporting progress objectively

• Providing the visibility of potential challenges

Processes include at a minimum:

• Definition and documentation of project organization and
planning techniques: a Work Breakdown Structure (WBS),
Organizational Breakdown Structure (OBS), Responsibility
Assignment Matrix (RAM), Budget Management, Schedule
Management, Change Control, etc.

Earned Value Management Solution
Winner of the 2007 Information Worker Solutions Microsoft Enterprise Project

Management Partner of the Year Award
Jay Mancuso, Program Management Consultant, Pcubed (MPA Member, Frontrange Chapter) and Sean O’Brien, Senior Vice President, 

Pcubed (MPA Member, New York City Metro Chapter)

Continued on page five

• Definition of planning values for each work element or
work package

• Definition of “earning” rules for which work accomplishment
is recognized

• Application of formulated calculations for measuring
progress and forecasting project outcomes

Successful practitioners of EVM have instituted the fundamental
elements described above as a means to improve the success rate
on their projects and programs. While this reflects EVM from a
methodology and process standpoint, most organizations
augment their processes with the use of automated scheduling,
accounting and cost control tools. 

Figure 1 depicts a generic example of how processes and
systems are integrated to achieve a sound EVM capability.

Figure 1. EVM Process and System Integration

Enabling processes with technology applications can be
complex and laborious as it typically requires integration with
multiple and disparate systems. 

Recognizing this challenge, Pcubed and its development partner
Friedrich, Klatt and Associates, have developed a solution that
simplifies the ability to seamlessly integrate process with
technology and achieve a robust EVM capability. Leveraging
Microsoft Office Project Server 2003 or 2007 and Microsoft SQL
2005 for its data mart and custom OLAP cubes, the solution
provides a means for embedding EVM processes, integrating
cost and schedule data, and accessing and assembling data for
required reporting outputs. Figure 2 shows the architecture of
the Earned Value Management Solution.
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Solution - Continued from page four

Figure 2. Earned Value Management Solution Architecture

The solution allows for any project staff member such as
schedulers, work package leaders, or control account managers
to plan work packages representing the WBS in Microsoft Office
Project Professional. Each work package is coded with an earned
value type to determine how it will accrue value, for example
50/50, 0/100, or physical % complete. Based on the “as of”
status date, the solution determines the amount of the planned
value, and based on the % complete progress update, the
solution determines the value earned. This data is combined
with the “as of” date actuals coming in from any cost and time
accounting system to bring together the Actual Cost of Work
Performed (ACWP). All data is stored in a data mart, which can
be used to create numerical or graphical views of key
performance indicators such as planned figures, variances
against baselines, and estimates regarding completion. Figure 3
and Figure 4 show sample reports.

Figure 4. Cost Performance Report based on EVM

In summary, the Earned Value Management Solution succeeds at
combining the discipline of EVM methodologies and processes
with “state of the art” technology. It seamlessly integrates and
reports project data based on EVM criteria and best practices,
ultimately leading to a greater chance of achieving project success.

Figure 3. Earned Value View in MS Office Project Web Access
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Ihave always been a fan (and in fact a major proponent) of the
idea of iteration in the long term deployment and roll out of
Project Server across an organization. Russ Young of

QuantumPM and myself were one of the first ones to talk about
this in the Enterprise Project Management Deployment Guide
way back during the Project Server 2002 days. Our work in this
area was based on ideas that were widely held not only in the
Project Server consulting world, but in almost all enterprise
software organizations. These iterations were fairly large scale
ones dealing with the staged, incremental roll out of Project Server
to the many organizations within a larger organization as opposed
to the massive one-time dropping of Project Server on the entire
company. This approach started with a small, but representative
(as much as possible) group, or small organization. Then using
the lessons learned from this group, the system would be adjusted
(new fields added, new views, server architecture adjusted, etc.)
and then another group would be added. This process would
repeat until the entire organization was using the tool. Each
iteration added not only new people, but also new or fixed
functionality in the form of views, security, process, etc. This
method is now used by virtually every consulting company doing
Project Server deployments.

The kind of iteration I’m talking about here, happens on a much,
much smaller scale and deals with the actual design and
production of the configuration of the Project Server system for a
given organization. Instead of dealing with the successive roll out
to new organizations, I’m now talking about the iterative
design/build loops around adding new fields, views, or security
configurations within any one of those larger iterations.

Understanding of the Environment and the Problem(s)
to be solved

This includes the collection of what the users want the system 
to do for them, in addition to the observation of the system at
work. This allows you as the consultant, to help make suggestions.

Configuration/Build

From the knowledge gained so far, the system is configured to
the best of your ability. This includes: fields, views, security, etc. 

Simulations

Most organizational uses of tools like Project Server, revolve
around the capture and editing of project data and the subsequent
use of that data to make specific business decisions that effect the
ability of the organization or project team to function with regard
to projects. I look at kernel, the very core of Project Server’s use in
an organization, as the understanding of data via views or reports
by decision makers. Everything else that project Server does
supports this in some way or another. With this driving principle

Ask Brian

Iterative Design/Build Loops in the Configuration of Project Server
Brian Kennemer, EPM Services Solution Group, COE Group, Microsoft Corporation 

“endlessly obsessing about Project Server so you don’t have to”; http://www.projectified.com

in mind, the check or test of the configuration/build ‘stage’ is a
simulation. Here decision makers use the tool as it is currently
configured to simulate the decision making processes they must go
through to manage their work/projects/portfolios/etc. These
simulations have the decision makers using the tool in a
conference room, with the design team and other decision makers
up on a projector. The team talks through the decisions they need
to make and what data they would need to see to make them.
Points of discussion include: How it would need to be displayed,
grouped, sorted, how it should be secured, who can see it, who
can’t see it, etc. All efforts are directed toward a better
understanding of how the tool will be used and what decisions it
will be used to support.

Revisiting the build stage…

At this point, we jump into a loop of Configuration/Build and
Simulation loops that successively improve the suitability of the
Project Server configuration to the needs of the decision makers
that will be using it to run the business/projects/work. If this
means new views or fields, then so be it. If it means configuring
and rolling out the use of timesheets to those doing the work, or
the development of custom OLAP cube building routines to
provide company specific data in Portfolio Analyzer views, then
that is fine too. The point is that the design/configuration happens
based on simulated use of the product as it is configured currently.

This process can take place either prior to the system “going live”
or as part of the addition of new users to the system. Also, a
variation on this process happens on an ongoing basis while the
system is being used by the organization. As people touch the
system and use it as part of their project management/portfolio
management processes, their new experiences and new
expectations, often become new requirements for the system. The
administrator of the Project Server system should constantly
collect suggestions and new requirements and evaluate them with
the team for inclusion in the system. This constant updating of the
product’s configuration ensures that it keeps up with the most
current processes in use within the organization.

Obviously, this is not rocket science and I’m not claiming to have
‘invented’ it by any means. I’m sure that many others are using
similar processes for their Project Server (or other PM software) roll
outs. I should also mention that this process is only suitable where
the organization is able to devote several weeks (at least 3 or 4) to
this initial design process. Often organizations that are rolling out
Project Server have only a very short time to do their initial design
and configuration. In cases like this, the process laid out here may
require too much time. But it should be said that while this process
requires more time than many methodologies, it is much more
likely to produce a usable system. Shorter term processes get you
up and running very quickly, but at the cost of fully understanding
the processes and needs of the organization.
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The YJTJ™ Process: An MPA Interview with Dan Renier
Dan Reiner, Principal Consultant, Milestone Consulting Group (MPA Member, Twin Cities Chapter) 

MPA is committed to serving the Microsoft Project user.
Toward this end, we consistently strive to make strong,
relevant information available to the Microsoft Project

practitioner. Recently, MPA sat down to address Milestone’s
YJTJ™ Process as this process, as noted by Microsoft Project
users, is strong, highly relevant information.

MPA: Dan, what is Milestone’s YJTJ Process? 

Simply put, YJTJ is a mindset for working effectively as a project
manager using Microsoft Project. The YJTJ process is designed to
assist project managers with understanding their responsibilities
with initiating, planning, executing, controlling, and closing
projects, and how to work through the extremely rich features
of Microsoft Project to support this process.

In order to work effectively with Microsoft Project, you must
understand what Your Job (YJ) is and what the Tool’s Job (TJ) is
at every point throughout a project lifecycle. Once you
understand this process, you are provided with an ability to
work in concert with Microsoft Project as opposed to in conflict.
Simply stated, you know exactly what you need to do and what
you should consistently expect Microsoft Project to do.

For Microsoft Project Standard and Professional implementations,
we work very closely with management teams to determine what
we call “critical success factors” for a successful deployment.
During this process, at some point, at least one management team
member will state the following: “Dan, you must get our project
managers to a point of spending more time managing projects and
less time working with and being frustrated by Microsoft Project.”
This statement becomes a primary critical success factor, and is
addressed through our YJTJ process.

MPA: Does YJTJ apply to a particular version of
Microsoft Project?

No. YJTJ is applicable to every version of Microsoft Project from
the very first release through Microsoft Office Project 2007. It is
applicable whether you are working on large projects with
multiple shared resources using Microsoft Office Project Server
2007 or managing a small project with a prior release of the
desktop tool.

MPA: So, if I am a project manager using Microsoft
Project, what is my job and what is the tool’s job?

To address this, let’s begin with the YJ part of the acronym. Your
job as a project manager begins with possessing a good
understanding of globally accepted project management
principles and a solid understanding of your organization’s
interpretation and utilization of such principles. Once
understood, you should then use Microsoft Project in a manner
that supports and allows you to visualize your organization’s
project management process.

From a Microsoft Project perspective, on the surface, YJ is
actually very simple and may be stated as follows: your job is to
provide Microsoft Project with information related to the
schedule, and nothing else. That in itself allows Microsoft
Project to be exactly what it is primarily designed to be, a
scheduling tool. YJ entails a good understanding of Microsoft
Project which may gained through understanding the YJTJ
process as it applies to all phases of a project Microsoft Project
supports.

MPA: So what type of information do you categorize
as YJ?

Microsoft Project knows nothing about your company, the
business you are in, the unique product or service you are trying
to introduce, who is working on your project, the deliverables
you must produce, or the activities you must perform in order
to close your project. You do. You bought Microsoft Project as a
trusted advisor to help you figure out, document, and
communicate when your project’s activities, deliverables,
phases, and the overall project are going to start and finish.

Therefore, based on this information, YJ is to feed Microsoft
Project the information it knows nothing about. This includes,
but is definitely not limited to: what phases are appropriate for
this project? What deliverables need to be produced? What
activities need to be performed? What are the dependencies
between deliverables and activities that must be honored by
nature or by defined process? Who has the requisite knowledge
to complete each of the tasks? How much effort (work) your
experts believe is required to complete tasks? etc.

Once you provide Microsoft Project with this basic information, it
will do exactly what you bought it to do - produce an accurate
schedule. Microsoft Project will tell you when tasks, deliverables,
phases, and the overall project start and finish. And, if desired,
you can bring the availability of your experts into the equation
and have the schedule account for resource availability. From a
scheduling perspective, at all times, the “task” start and finish
fields are Microsoft Project’s job. We never touch task start or
finish as that is the tool’s job! And, throughout the life of a project,
there are many other fields that fall into the YJ or TJ category
depending on a number of factors. The YJTJ process goes much
deeper than just task start and finish.

MPA: Wait a minute here, Dan. You’re telling me you
never touch the start or finish fields in Microsoft
Project. We live in the real world and there are
deadlines to meet. Naturally, I have to tell Microsoft
Project when certain tasks are going to end.

To address your first statement, we never enter values in the task
start and finish fields. There are other start, finish and date fields
in Microsoft Project that are perfectly acceptable to enter values
into, and at times very important to do so. 

Continued on page eight
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MPA Interview - Continued from page seven

To your second statement, it is true that we all have deadlines 
to meet. Have you ever been handed a date you need to
complete an activity by, and then manually entered the date in
the task finish date field? When you do so, it is very important
to know that Microsoft Project is programmatically designed to
think finish-no-earlier-than when you are thinking finish-no-
later-than.

For example, let’s assume you have been instructed to finish the
“Develop” task no later than November 16, 2007. When you
enter 11/16/07 into the task finish field, Microsoft Project has
now instructed the task to finish no earlier than 11/16/07 as
shown by the constraint indicator (Figure 1). 

schedule, you still need to solicit expert judgment work and/or
duration estimates and input that information into Microsoft
Project. Based on this task, resource, and assignment
information, Microsoft Project will build the schedule and tell
you when tasks, deliverables, phases, and the overall project will
start and finish (TJ).

If you don’t like the answer Microsoft Project gives you, you
need to do your job as a project manager which includes but is
not limited to: negotiating with resource managers for additional
resources and/or availability of currently assigned resources,
negotiating an extension on a deadline date and/or the scope of
the project with the project sponsor, etc. If you must ask for an
extension, you will then have documented in your schedule all
of the information about the current scope of the project, the
natural progression of activities, and the resources allocated to
you, etc. You can then use Microsoft Project as a powerful tool
to illustrate your position during negotiations.

MPA: OK. I think I am beginning to understand.
What’s happening is that I am really using Microsoft
Project as a model to help me calculate a very
complex problem. Then I can try out the impact on
dates by adding resources, removing or simplifying
deliverables, starting design before requirements are
completely done, and so on.

Exactly!

MPA: There are so many other features in Microsoft
Project, especially when we start talking about
resource management and a resource pool in the
Microsoft Project Server tool. Aren’t you really
missing a lot of what Microsoft Project really does?

That’s a very good question. Particularly when managing
complex projects in the enterprise tool, you need Microsoft
Project to calculate dates for you. Based on these dates and when
tasks start and finish, Microsoft Project can tell you when the
resources will be needed for work. It is this basic information
that gives you a graph of overall resource commitment. Along
with your schedule and resource allocation, Microsoft Project is
also calculating costs, variances from baseline, and a host of
other related information.

MPA: That makes sense. Now how about those dates
I have to meet?

The key is in knowing how to tell Microsoft Project the
information you have gained from doing your job. As stated in
the earlier example, YJ is to enter a Constraint Type (Finish No
Later Than), a Constraint Date (November 16th, 2007), and a
Task Note describing the reason for constraining the schedule
(good project management communication principles). 

If you input information into Microsoft Project in this manner
(YJ), Microsoft Project will communicate with you through the
Planning Wizard and the Gantt Chart when a conflict arises (TJ)
as shown in Figures 3 and 4: 

Figure 1. Finish No Earlier Than constraint indicator

And, as evidenced by the Smart Tag text that may be displayed
when you edit the task finish field, even the engineers at
Microsoft will agree, that entering a value into the task finish
field is not a best practice (Figure 2).

Figure 2. Smart Tag text

In this example, YJ is to enter a Constraint Type, a Constraint
Date, and a Task Note describing the reason for constraining the
schedule. Microsoft Project’s job, according to YJTJ, is to manage
task start and finish dates at all times (TJ).

MPA: OK. I’m not sure I quite understand, I think
you better tell me a little more about this then.

Basically, you start with a good planning process beginning with
task planning. The task planning process includes: building out
your Work Breakdown Structure, adding dependencies between
tasks observed by nature or defined process, and by adding
known constraint and/or deadline date information. Next, you
build a team of experts to be assigned to tasks to complete the
resource planning process. And finally, you assign resources to
tasks based on each resource’s availability and expert judgment
work and/or duration estimates to complete the assignment
planning process. If you do not input resources into your

Continued on page nine
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MPA Interview - Continued from page eight

Figure 3. The Planning Wizard message regarding a
scheduling conflict

scope all in an effort to bring the schedule back in line with
client commitments. 

To reemphasize, the tool’s job is to inform you as to what will
happen to the schedule, i.e. task start and finish dates, based on
the information you have provided. Your job is to stay focused
on good project management and communications principles in
an effort to resolve schedule conflicts, and to allow Microsoft
Project to manage task start and finish dates at all times!

MPA: What do I need to know about Microsoft
Project to get started with YJTJ?

YJTJ is a mindset. There are numerous best practices we have
developed for different scheduling/management scenarios that
discuss which fields are YJ and which are TJ in each scenario. It
is helpful to remind yourself that it is the Tool’s Job to schedule
tasks and think carefully about that as you work. If Microsoft
Project doesn’t do what you expected, the first question you
should ask yourself is, “Did I just try to do the Tool’s Job?” Your
next question should be, “Did I give Microsoft Project all of the
information it needs to reasonably do its job?”

The mindset is fairly simple, and is enough to get started. As you
develop your skills and you work with more complicated
projects, you will want to acquire additional modeling tools. 
You can do this through training, consulting, discussion with
your fellow project managers, or by trial and error. The YJTJ

Figure 4. Gantt Chart view displaying a scheduling conflict

Your schedule is free to adjust as necessary, but Microsoft Project
will let you know through the Planning Wizard if you have a
problem meeting a commitment. At this point, it is time to do
your job as a project manager by negotiating for items such as
additional resources, deadline extensions, and/or a reduction in Continued on page ten
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MPA Interview - Continued from page nine

process goes much deeper, however, than what is required to
simply get started.

MPA: What feedback have you received from people
that have adopted this mindset?

Our number one point of feedback has been nearly universal.
Regardless of whether people like or dislike Microsoft Project,
they understand what to expect from it. Every level of
management has been satisfied with the results from their unique
perspective. We have numerous senior managers, resource
managers, and project managers available for comment if desired. 

We do admit, however, that for some people the first time they
sit through the introductory YJTJ presentation they have trouble
understanding how you could possibly use Microsoft Project
without ever touching the task start and finish fields. We know,
however, if they put the YJTJ principles into action, and even
attend the introductory YJTJ session a second time, that they
become believers. It is this belief and day-to-day practice that
greatly assists organizations with achieving the primary critical
success I hear so often: “Dan, you must get our project managers
to a point of spending more time managing projects and less
time working with and being frustrated by Microsoft Project.”

Simply stated, YJTJ is a process that greatly assists organizations
with realizing a positive ROI on their Microsoft Project investment!

MPA: Where can I go to get more information on
applying YJTJ™?

YJTJ is a little bit difficult to explain in text; therefore, it is better
to see it in action. If you are fortunate enough to have a DVD from
the Microsoft Office Project Conference in 2006, you can watch
the full introductory YJTJ presentation. If not, you can get a copy
of a YJTJ presentation slide deck from the National Association of
Technology Professionals (www.nwaitp.org). You can also send
an email to YJTJinfo@Milestone ConsultingGroup.com to
request information. 

Please note that the introductory YJTJ presentation was initially
created for what was known as the Microsoft Project Global
Customer Advisory Council. Through four days of presentations,
it was the top-rated session. This presentation has been received
extremely well at MPA and PMI chapters in the United States, at
Microsoft offices in the United States, and most recently at
Microsoft in Israel. We highly recommend this presentation for
MPA and PMI chapters around the world! Please note that the
introductory YJTJ presentation will be delivered at the Microsoft
Office Project Conference scheduled October 29 – 31, 2007, in
Seattle, Washington. Any organization wishing to schedule the
introductory YJTJ presentation may do so by sending an email to
YJTJinfo@ MilestoneConsultingGroup.com.

MPA: Thank You, Dan.

You’re very welcome!
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Send Your Tracking Change Requests in Project
Bonnie Biafore, PMP, President, MonteVista Solutions, Inc. (MPA Member, Frontrange Chapter)

Continued on page twelve

When a project doesn’t run exactly as planned (which is
most of the time), you update your Project file with
actual values and sometimes adjust the schedule to

get things back on track. But what about changes that people
ask for—enhancements, requirements that weren’t spelled out
in the original plan, or new and improved approaches to project
tasks? Change requests require the same care and feeding as the
original tasks in your project, although transplanting them into
your Project file sometimes requires a few extra steps.

This article describes ways to use Project to evaluate change
requests in a Project schedule, so your change control board (or
whoever approves change requests) can make informed
decisions. You’ll also learn how to add approved change requests
to a Project schedule and incorporate them into your Project
baseline so you can track them along with original tasks. This
article also describes a method for identifying tasks that relate to
change requests so you can easily put them in the spotlight. 

Evaluating Proposed Change Requests

In all but the most laissez-fair change management processes,
someone has to approve a change request. Predictably,
approvers want to evaluate change requests before they say
yes—why it’s needed, how much it costs, how it affects the
schedule, and so on. You don’t want to gunk up your Project
schedule with change requests that might not be approved. A
what-if copy of your Project file is just the ticket; it shows the
effects of change requests without a single change to your
working Project file.

Note: Project 2007’s multi-level undo (yippee!) is one way to play
what-if games with your working schedule, but it has some
drawbacks. Multi-level undo works only until you save your Project
file. Approvals usually take time and keeping your Project file open
for that length of time isn’t realistic. However, you could make
changes to a Project file during a change control board meeting and
use multi-level undo to back out change requests that the board nixes. 

A change request typically includes an estimate of the impact on
schedule, cost, scope, and quality. Many change control boards
approve change requests based simply on these estimates, for
example, $2000 and 2 days. For major change requests, such as
adding a new model to the product lineup or a big project scope
reduction, the impact requires careful study. If you want to see
how change requests affect your project schedule, consider one
of the following approaches:

• One change request per what-if Project file. The purest
view of a change request’s impact comes from adding only
that change to a what-if Project file. Any date, cost, or other
changes are the result of that change request alone. This
approach is ideal for big ground-shaking change requests.

If you manage many small change requests, the overall impact
may not match that of the individual change requests. For

example, the project finish date might not move very much if
you can assign change requests to different people.

• Recommended change requests in a what-if file. Another
approach is a what-if Project file that includes all the change
requests you think should be approved—like the
shareholder ballots that recommend how you should vote
for corporate directors. The change control board might
approve all the change requests if the schedule and budget
are still acceptable.

Note: If you think the change control board is in a generous mood, 
you can create a second what-if file that includes all submitted 
change requests.

Copying a Project file to create a what-if file is a slam-dunk;
choose File➔Save As and give the what-if file a unique 
and meaningful name. For example, rather than naming a 
file WaterlessIgloo2.mpp, name it WaterlessIgloo_
CREval070630.mpp or include individual change request
identifiers like WaterlessIgloo_CR462.mpp.

Setting a baseline before you add change requests is the key to
evaluating change request impact. You can compare the new
dates, cost, and resource workloads to the pre-change request
baseline. Here’s a quick review of setting a baseline:

1. Make sure that the what-if copy is the active Project file.
(The name of the active file appears in the main Project
window title bar and appears in a darker color in the
Windows taskbar.)

2. Choose Tools➔Tracking➔Set Baseline in Project 2007. (In
Project 2003, it’s Tools➔Tracking➔Save Baseline.)

3. In the Set Baseline (or Save Baseline) dialog box, choose the
baseline you want to use in the Set Baseline (or Save
Baseline) drop-down list and then click OK.

Don’t select a baseline with a date to the right of its name,
which means the baseline has already been saved. Resaving
it overwrites the baseline values with the current values.

4. Edit the file to incorporate the change requests.



12

Tracking Change - Continued from page eleven

5. Use your favorite techniques to evaluate the impact of the
change requests. For example, in the Tracking Gantt view,
baseline task bars show the project before adding the
change requests, while the current task bars show the
project including change requests. You can see the variances
that change requests generate by displaying tables like
Variance, Work, or Cost in a Gantt view.

Setting Up Change Requests in a Project File

With those approved change requests burning a hole in your in-
basket, you must add them to your Project file in order to track
their progress. In addition to adding change requests to your
working Project file, you must decide how to incorporate them
into your Project baseline.

Adding Change Requests to a File

A what-if copy might be the quickest way to get change 
requests into a working Project file, but this approach works
only if your working Project file hasn’t been updated in any way.
That is, you haven’t added new actual values or edited the
schedule in other ways. You can simply rename the what-if file
and add any missing details like accounting codes or custom
field values, and then rename the original and the copy. (Append
“_Orig” or a date to the original filename, for example,
WaterlessIgloo_Orig.mpp or WaterlessIgloo_20071014.mpp. Then,
rename the what-if copy to the name you use for the working
file, WaterlessIgloo.mpp, in this example.) 

If your working Project file contains new information, you’re
better off adding change request tasks to the current working
file. Use one of the following methods to include change
requests:

• Copy tasks. If change requests are standalone tasks, you
can copy the tasks from the what-if file into your working
Project file.

In the what-if file, select tasks to copy by clicking or
dragging across their task ID cells (the leftmost column in
the table area of a view). Press Ctrl+C to copy them to the
Clipboard. Switch to your working file (choose Window
and then choose the file name). Click the row where you
want to insert the tasks and press Ctrl+V to paste them.
Project inserts the tasks above the row you select.

• Modify tasks. You can also incorporate change requests by
editing tasks directly in your working Project file. For
example, if a change request adds work and duration to an
existing task, edit the task as necessary.

• Remove tasks. You don’t actually delete tasks that a change
request eliminates. Instead, change their remaining work to
zero (0). This approach leaves the original baseline values in
place, but shows the eliminated tasks as complete.
Successor tasks can start earlier and you can reassign the
resources to other tasks.

To edit these tasks, right-click the Task Form (in the default
Gantt Chart view) and choose Resource Work. In the top

Continued on page thirteen

pane of the Gantt Chart view, select a task you want to
“remove”. In the Task Form in the Rem. Work column
(Remaining Work), type 0 and click OK.

Baselining Change Requests

How you baseline change requests in your Project file depends
on how you want to track approved change requests. For
example, if you have a hardhearted client who wants you to
complete change requests within the original schedule and
budget, you might want to keep your original Project baseline as
it is so variances represent the divergence from the original plan.
Here are three options for baselining change requests:

• Adding tasks to a baseline. If your change requests are
new tasks, you can add those tasks to a baseline. (Select the
tasks you want to add and then choose
Tools➔Tracking➔Set Baseline (Save Baseline in Project
2003). In the Set Baseline (Save Baseline) dialog box, select
the “Selected tasks” option.

For that hardhearted client, you want to set a baseline for your
change request tasks, but you don’t want to overwrite the
original project baseline values. The answer is to turn on the
From Subtasks Into Selected Summary Task(s) checkbox.
With this setting, change request values update only summary
tasks you select, for instance, only the summary tasks to
which the change requests belong. You can review change
request progress by comparing current change request values
to their baseline values. At the same time, higher-level
summary tasks show their original baseline values, so
variances show any divergence from your original plan.

If you turn on the To All Summary Tasks checkbox, Project
rolls up the new baseline values into all summary tasks up
to the Project summary task. This is perfect when you want
the Project baseline to reflect the additional cost and time
that the change control board has approved.

Setting a new baseline. If a change request represents a
major overhaul to your project, you can set a baseline of the
project including the change requests. Then, you can track
progress against this more recent baseline.

Choose Tools➔Tracking➔Set Baseline (Save Baseline). In
the Set Baseline (Save Baseline) drop-down list, choose the
baseline you want, select the Entire Project option, and
click OK.

Note: If you want Project’s variance fields to show the variances
compared to this new baseline, choose Baseline in the Set
Baseline drop-down list.

Saving a data cube instead of a baseline. If you don’t want
to use up one of Project’s 11 available baselines, you can
save your Project file as a data cube with the help of Project
2007 visual reports. A data cube saves a snapshot of project
data into a special kind of database that you can view in
Excel or Visio. You can use these data cubes to retrieve data
by different categories, for example, to evaluate progress for
change requests.

After you baseline change request tasks, entering actual values is
the same for original, modified, or new tasks. Type values in
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fields like Actual Work or import values from a time-tracking
system.

Highlighting Change Requests

Viewing change requests by themselves is useful when the
project sponsor or customer develops amnesia about having
approved a change. One way to spotlight change request tasks is
with a custom field that flags them as change request. Then, you
can filter a view to show only the tasks with the change request
flag. Here are the basic steps:

1. Create a custom field for tasks. Choose Tools➔
Customize➔Fields.

If you want to flag tasks by their change request identifier,
use a text or number field. (Then, you can type the change
request number or name in the field.) To simply track tasks
as change requests, use a Flag field, which you set to Yes for
change requests and No for original tasks. Name the field
something like Change Request.

2. Insert the custom field into a table, for example, the Entry
table of the Gantt Chart view, shown in the screenshot.

Double-click a column heading in the table. In the Column
Definition dialog box, in the Field Name drop-down 
list, choose the custom field name, which looks something

like Flag 1 (Change
Request). As you type
letters, Project searches
the field list by both the
built-in field name and
the alias you create. For
example, you can type
F to jump to Flag fields
or, you can type C to
find Change Request
(Flag 1).

3. For every task that relates to a change request, type a value
in the custom field.

The value would be Yes in a Flag field, but it could be
something like 2008/01 CR in a text field or 121 in a
number field.

Display change request tasks by choosing Project➔Filtered
for➔AutoFilter. In the change request flag column, click the
down arrow and choose a filter value like Yes.

To remove the filter, click the down arrow and choose (All).

Certification - Continued from page one

scheduler, or another role that requires the ability to
formulate well thought-out project plans and to manage
projects effectively. Those pursuing this certification may be
responsible for the scheduling, estimating, coordinating,
controlling, budgeting, and staffing of projects. 

• The MCTS: Enterprise Project Management with Microsoft
Office Project Server 2007 certification provides industry
recognition to project managers and other professionals
who use Microsoft Office Project Professional 2007 and
Office Project Server 2007 to manage and support projects
in an enterprise environment. Candidates for this credential
may use Office Project 2007 or Office Project Server 2007
to manage project and non-project efforts, risks, issues,
documents, task progress, and timesheets. 

The MCITP: After earning the MCTS credentials, students can
then advance their project management career by achieving the
advanced Microsoft IT Professional certification which is
focused on Project Management as a specific job role. Enterprise
Project Management with Microsoft Office Project Server 2007
certification provides industry recognition to project managers
and other professionals who use Microsoft Office Project
Professional 2007 and Office Project Server 2007 for individuals
managing large and complex programs and projects throughout
the enterprise. 

Got Certification?

More companies outside the traditional IT realm are now
ditching spreadsheets and turning to Project Management tools

that focus on metrics and team communication. They are
looking to increase productivity and streamline operations with
measurable results. In doing so, they are differentiating
themselves from competitors and better accommodating their
distributed workforces.

So now is a great time to take your project management career to
the next level by investing in the Office Project 2007 certifications.
No matter what type of Project Management role you perform,
these certifications can benefit you and enhance your professional
standing in the project management community.

Listed below, please find additional resources to help you learn
more about the new Office Project 2007 curriculum and
credentialing program:

• Join MPA7 and learn about Project / Scheduling 
www.mympa.org/ mission.aspx

• Take the training from a Partner organization
www.microsoft.com/learning/training/default.mspx

• Take the MCTS Office Project 2007 70-632 exam
www.microsoft.com/learning/mcp/mcts/project2007/pm/
default.mspx

• Learn about the upcoming MCTS and MCITP Office Project
certifications
MCTS www.microsoft.com/learning/mcp/mcts/default.mspx 
MCITP www.microsoft.com/learning/mcp/mcitp/default.mspx.

1 PMI Network June 2007 / Volume 21, No. 6 Failure is Not an Option
2 The Standish Group’s Quarterly Research Reports www.standishgroup.com/quarterly_reports/index.php
3 Project Management Institute www.pmi.org 
4 Project Management Institute Certification Program

www.pmi.org/info/PDC_CertificationsOverview.asp?nav=0401
5 PMI Today (ISSN 1040-8754) published monthly by the Project Management Institute(PMI)

www.pmi.org/Resources/Pages/PMI-Today.aspx 
6 Projects @ Work, May 22, 2007 www.projectsatwork.com
7 MPA The Official Industry Association for Microsoft Office Project www.mympa.org
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“Got To Get You Into My List” – Part One
Ira Brown, President, Project Widgets (MPA President, Philadelphia-Delaware Chapter)

If you have ever worked with custom fields in Microsoft
Project, you are probably familiar with the concept of a
“value list”. Value lists are particularly useful for restricting

the allowable values for a custom text field.

One of the challenges of administering value lists, is getting the
list populated in an easy manner. Although it is possible to copy
one value at a time to a value list, Microsoft Project does not
provide the capability to copy an entire value list in one easy step.
Similarly, you may also have the need to copy an entire value list
out of Microsoft Project for use in a document or spreadsheet.
Again, there is no way to grab the entire list in one step.

This is where Microsoft Project’s programming language, Visual
Basic for Applications (VBA), can make this task a whole lot easier.

This article (Part One) will provide you with an example of
using VBA to populate a value list. In the next edition of the
Project Network, I will provide you with an example of how to
extract values from a value list (Part Two).

Adding Values to a Value List

1. Start Microsoft Project, and from a new, blank project,
either type or copy and paste the values you want to use for
your value list in the “Task Name” column. This serves as a
good technique for allowing you to programmatically
populate a value list directly from a list of tasks. 

In this example, I will show you how to create the code to
populate the task Text1 field’s value list with the names of
all 50 states.

For Each t In ActiveProject.Tasks
CustomFieldValueListAdd pjCustomTaskText1, t.Name

Next t

End Sub

2. From the menu in Microsoft Project, select Tools…
Macro…Visual Basic Editor. 

3. From the menu in the Visual Basic Editor, select Insert…
Module.

4. Type the following code in the module window, as pictured
below.

Sub PopulateValueList()
Dim t As Task

Note: Depending on the field whose value list you want to
populate, replace the “pjCustomTaskText1” field with
appropriate field constant. For example, to populate the value
list for Enterprise Project Text10, you would use the constant
“pjCustomProjectEnterpriseText10”.

To run the code, click the Run Sub/UserForm button, as shown
below:

That’s all there is to it! As shown below, your value list is now
populated with the names of all fifty states!
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One of the best ways to analyze and manage your resource loaded Project schedule
is to customize (change the default configuration) the Task Usage and/or Resource
Usage Views to meet your needs. These views bring together task information and
resource information to provide assignment information. 

First, we need to understand what we’re seeing when we look at the assignment
views. The Task Usage View, for instance, lists the tasks in the schedule. Below each
task is a resource assignment which provides us with information only relevant to
the assignment of that resource to that task. The Resource Usage View lists resource
names and below each, in italics, are the task assignments for that resource. This
view provides us with information only relevant to the assignment of that resource
to that task. The task could have additional resources, more work hours, etc., but
you will only see the hours of work for that single resource on that single task.

Let’s take a look around…you can open any MS Project schedule with tasks and
assigned resources. From the View menu, we’ll choose Task Usage...

Notice the tasks have
resource assignments. If
you select an assignment
and use the “Go to selected
task” button from the
Standard toolbar, the time

phased grid on the right will take you to the date where the assignment begins.

Note: The Task Information button just became the Assignment Information
button too!

Working in Customized MS Project Assignment Views
Genea Mallow-Jensen, Manager, Enterprise Management, PMP, MBA ITT Systems, PMCOE (MPA Member, Frontrange Chapter)

“Work” in the right time-phased pane, is referring to scheduled work hours.
Warning: Adjusting the hours in the white cells of the right pane can change the
total work hours on the task, the duration of the task, and even the cost of the
project. 

The white cells in the right pane allow data entry, the yellow cells are summary
cells. Making adjustments in the summary (yellow) cells may cause changes in
your schedule that you do not intend to make and therefore, is not recommended.
Changes should be made in the white cells.

Suppose we want to see other details in the right time-phased grid, like Cost. Just
right click in the yellow area and choose Cost from the list. Now the right pane
should show Work hours and Cost for that resource assignment, for that day, based
upon the resource rate. 

You probably noticed that Cost was not the only
option when you right clicked in the yellow right
pane. You can add rows for any of the elements
listed or you can choose Detail Styles… from the
top of the list to see all the elements available to
add to your time phased grid. Just select the item
from the list on the left of the Detail Styles box and
choose Show and then click OK to add a row for
each item in your timephased grid. Use the Zoom
In and Zoom Out buttons to change the time
phased grid to a weekly view, monthly view, etc.

MS Project 2003 - P.O. Template, Task Usage View
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WBS Chart Pro - Your Next Project Reporting Tool
Al Callan, PMP (MPA Member, Puget Sound Chapter)

In September of 2006, Carl Chatfield, co-author of “Microsoft
Office Project 2007 Step by Step,” was a guest speaker at the
MPA Puget Sound Chapter (MPA-PS) meeting. The MPA-PS

Chapter has the good fortune to be in the Microsoft
neighborhoods and as such, gets added benefit of having guests
like Carl speak at chapter meetings. Carl’s background and
knowledge on the product is rivaled by few…remember, he
wrote the book! And so, with Carl at the helm of his Project
2007 PowerPoint demo, I settled in with a fresh coffee
(remember, this took place in Seattle) and waited for the curtain
to rise on the Project 2007 feature set that piqued my interest
most…visual reports.

Leading up to Carl’s presentation, I had, like so many others,
spent my career using a desk-top version of MS Project. The
nirvana of working with a Project Server instance was a distant
reality. And, like many of my colleagues, I have always been
challenged to leverage the canned reports of pre-2007 versions
to communicate with my key stakeholders. So, over the years, I
got creative and used other products like Visio, Excel and
PowerPoint and Front Page to tell my Project story.

One of the many disadvantages of using disconnected
applications as a reporting tool, is that they are not synchronized
with the MS Project Data. So, any time there are changes in your
MS Project file, you have to manually update the respective
(Visio, PowerPoint, Excel, etc.) files. As I’m sure you know, that
can be both extremely time consuming and frustrating. The
value propositions that exist for Project Server and Project 2007
Visual Reports are the drivers for desk-top users getting creative
to solve the problem with stand-alone applications. 

And so, as Carl wrapped up his demo on MS Project 2007 visual
reports, I was excited to get started with this awesome new
capability. But for other non-2007 users in the audience, they
still had the same old challenge. The solution, WBS Chart Pro, a
product of Critical Tools, Inc. Ironically, I found out about this
tool at the very same MPA-PS meeting that Carl demonstrated
Project 2007! The product was demonstrated by our other guest
speaker, Bruce Taylor. Bruce is a seasoned Project Manager
experienced in large-scale construction projects, and the
founder of MPA-PS. 

According to the user’s guide, WBS Chart Pro is a “Windows-based
project management software application that is used to create and
display projects using a Work Breakdown Structure chart.” 

Short of writing a nice lengthy product review, suffice to say, this
tool is designed to interface bi-directionally with MS Project. I’d
describe the tool as a visually strong and an easy-to-use WBS
tool that can also be used as a display/edit interface with MS
Project. And, oh yea, it’s extremely easy to learn. I ramped up in
about 15 minutes. 

For purposes of repeatability, I’ve used the MS Project 2007
template, “Software Project.” Inserted task 1 and indented all

other tasks. LEGEND: Blue = complete, Yellow = in progress,
Green = not started.

Progress View

Figure 1 shows a progress view for the “MPA_SW_Project.” This
simplistic, color-coded view of the project data is a very powerful
tool for both analysis, and communication to executives. One of
the beautiful features of this UI is that you can drill into detail on
the fly. Do you see any problems with this project?

Figure 1. “Progress View”

Critical Path View 2

Figure 2 is the “Critical Path View 2.” This is an awesome view
for activity definition and sequencing. You know, the fancy stuff
that every good PM does per PMBOK. I like to print this view
out in detail and hand it out to my teams, or send them an image
file. It’s amazing how such pictures become the plan of record. I
see people taping them to walls, carrying them around with
them from meeting to meeting and really getting in touch with
what a WBS is all about. 

In summary, the tool is quite slick.
However, I must emphasize that WBS
Chart Pro works the best when used in
concert with a good WBS! If you don’t
have a good WBS, you won’t have good
reports, amongst other problems. The
tool is a nice addition to any version of
Project. If you’re still pre-Project 2007,
this is an awesome solution to bridge
your reporting needs gap until you
realize the power of 2007 visual
reports. MPA and MS Project are truly
better together. Had it not been for that
September MPA-PS meeting, I wouldn’t
have known about WBS Chart Pro, or
had the edge on Project 2007 visual
reports. Best of luck to you! Figure 2. “Critical

Path View 2”
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The “Top Ten” Tips for New Microsoft Project Users
Michael A. Steinberg, PMP, Senior Project Management Consultant, Project Assistants, Inc. (MPA Member, Atlanta Chapter)

It seems that everyone today has a “Top 10 List”. So why
would we want to have one for Microsoft Project? Well,
think about these questions:

• How many of you have had formal training in Project before
or soon after you started to use it?

• How many of you felt frustrated with Project not behaving
like you expect it to?

• How many of you are able to get the tool to do what you
want every time?

In my experience of training,
mentoring and consulting with
users of the tool, I have found
very few people who can answer
positively to all of the questions
above. But, I have found that
with the proper training, and
understanding of a few simple
rules that govern the tool’s
behavior, users’ frustration levels
can be drastically reduced. 

This article is by no means intended to replace formal training,
but it can be used as a refresher, a reference, and a set of
guidelines so that the tool becomes the project manager’s friend
rather than a source of frustration.

So, here is my “top ten” (actually twelve) list of tips, guidelines,
or “rules” for understanding how Microsoft Project operates.  

I. It’s not a spreadsheet

This may seem obvious, but it’s worth a mention. A new user
may look at the grid-like layout of the default “Gantt Chart” view
and assume that because it looks like a spreadsheet that it also
behaves like a spreadsheet. They quickly discover that the tool
automatically performs some scheduling functions, like, for
example, changing start and finish dates. Not understanding
how or why it does this, they quickly become intimidated and
abandon the tool. The bottom line: Project is a scheduling tool.
Scheduling tools will change dates!

II. Know the basic scheduling formula

Duration = Work/Units

Understanding the definition of these three terms (See Project
Help), as well as the formula itself, is key to knowing how
Project schedules a task. To anyone who has changed any of
these three parameters on a task, without understanding this
formula, the changes that Project makes to the other
parameter(s) can sometimes seem totally unexpected or bizarre. 

In my experience, not knowing this formula is the biggest cause
of frustration that people experience with the tool. Knowing the

Continued on page eighteen

formula will not stop Project from doing things that you don’t
expect, but it will allow you to know what changes to make so
that it will do what you want.

III. Use Task Types correctly

What will Project do when you change either work, duration or
units on a task – that is, which of the others will it change and
which will it keep constant? The Task Type parameter is what
tells Project how to behave. The general rule is: 

If work, units or duration is fixed and you change one of the
others, Project will recalculate the third, but won’t change the
one that’s “fixed”.

Even if you don’t set Task Type explicitly, each task defaults to
one of the three – and the system default is “Fixed Units”. This
can cause problems in many cases, because since most technical
tasks are driven by the amount of work effort required, they
should generally be “fixed work”. 

IV. Estimate work, rather than duration

As mentioned in the previous tip, most technical tasks are
driven by the amount of work effort, not by duration. Therefore,
it is a good practice to estimate how much heads-down work
effort a task is likely to need, and estimate the number (or
fractions) of resources (which is the definition of units), and let
the tool calculate duration. 

Duration is dependent on many things – not only work effort
and assignment units, but calendars, task splits and a number of
other factors. Often, when we estimate duration first, we are
really applying the basic scheduling formula (Tip number 2) in
our heads. Why not let the tool do the math! 

V. Understand effort driven

If a task is effort driven, the total task work will remain the same
if you add or remove resources. If you add a resource, the total
amount of work effort will be divided among all of the
resources, including the new ones, thereby reducing duration. 

A good practice when adding resources to a task, even if you do
understand this concept, is to explicitly specify the work and
units for each assignment, so you remain in control of the
division of labor. Do this in a usage view or the bottom half of a
split-screen view.

VI. Don’t assign everyone at 100%

When you assign a resource to a task, the default level 
of “assignment units” is 100%. This means that the resource will
be assigned full time on that task for its entire duration! Is that
what you always want? Probably not, but it is easy to fall into
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that trap. This will result in a serious distortion of their true
allocation. Be especially careful when people are assigned to
concurrent (parallel) tasks. Be sure not to assign them full time
in these cases.  

VII. Minimize constraints

Constraints, such as “Start no earlier than”, or “Finish no later
than”, are really telling Project not to schedule a particular task.
Sure, there are legitimate uses for them, such as a dependency
on a truly external event. However, the best practice is to
estimate each task and its dependencies, and let Project adjust
the schedule. This is called “Dynamic Scheduling”. 

Hard (or “inflexible”) constraints such as “Finish no later than”,
should be avoided if possible. Hard constraints can cause
scheduling conflicts, where Project may be forced to choose to
ignore either a constraint or a dependency – again, a situation
where you are tying one hand behind its back.

“What if my sponsor mandates an end date?” you say. Use
deadlines instead. Deadlines will flag a missed milestone but will
not disable scheduling of the task. 

One note about constraints: When you manually key in a start
date, you are effectively setting a “Start no earlier than”
constraint. That is why project sometimes ignores a date that
you type in.

VIII. Avoid estimating percent complete 

Estimating percent complete is not a best practice for many
reasons, not the least of which is its vulnerability to abuse. A
better practice is to ask a resource (or manager) to report actual
work and to estimate remaining work, and let the tool calculate
percent work complete. (In fact, when we estimate percent
complete, aren’t we really mentally estimating those two
amounts and doing the math in our heads?) 

Another note: In Project, the “% Complete” field really means “%
duration complete”, as distinguished from the “% work complete”
field. Make sure you understand the difference and which you
want to use.

IX. Heed the planning wizard

Yes, those annoying messages like “This action will cause a
scheduling conflict…” are really your friend. They warn you of
potential problems, like the one described in the previous tip.
Deal with them immediately, because their consequences may
become more difficult to trace back to their root causes when
they are no longer fresh in your mind. 

X. Leveling is not a magic bullet

As anyone who has used automatic leveling knows, there is
really no magic to it. It simply delays the start (or continuation)

of tasks in your schedule until resources are no longer
overallocated. This is not always practical. 

The best practice is to use some thought when first assigning
resources to tasks. For example, don’t assign the same person
full time to two tasks at the same time. If you are careful,
leveling can work for you. If you are not, it is sure to make
things worse!

XI. Tools do not replace communication

With all of the collaboration tools in the Enterprise Project
Management (EPM) environment, like notifications and
SharePoint, one might be tempted to think the tool can
communicate for us. Wrong! Ninety percent of a project
manager’s job is interpersonal communication. EPM tools will
facilitate communication and relieve us of some of the more
mundane tasks so we can spend more time communicating –
but it won’t replace it. 

XII. Tool expertise will not make you a good 
project manager

This point expands on the previous tip. Microsoft Project is a
great scheduling tool. But that’s all it is. PMI® identifies 44
processes that a project manager performs. Project really only
supports a handful of those processes. As they say, “a PM tool
makes a good manager better faster and a bad manager worse
faster.” Microsoft Project will facilitate some of our more routine
scheduling tasks, so that we can devote the bulk of our time
truly managing our projects. 

Special thanks to Dr. Fred Oettle, Director of Training at Project
Assistants for articulating these concepts.

NEWSLETTER 
AUTHORS WANTED!

Do you have a Microsoft Project case study, tip or
technique to share with your fellow MPA
members? We are always looking for informative
articles that showcase your insight and expertise, 
and remember you can earn 15 PDUs for a
published article. If you have an idea or an article
that you would like to submit, please email
newsletter@mympa.org.
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Microsoft Project Server® and Microsoft SharePoint®: 
The Building Blocks to an EPM Solution: Part One of a Series

Nicholas Pisano, President and CEO, Safran North America, B.S, M.S., M.A. (MPA Member, New Mexico)

The traditional definition of Enterprise Project Management
(EPM) is “the field of organizational development involved
in the management of change involving either significant

transformation or a new development”. Under this concept,
management is usually achieved through the establishment of a
project or program discipline focused on the individual project or
program.

This definition, became inadequate and obsolete with the
introduction of more sophisticated information technologies and
organizational methodologies of the late 1980’s and 1990’s. As the
potential for greater access to and integration of information
generated by the information technology itself increased, it
created a demand that outstripped the technology that existed at
any one time.

For example, in the United States public sector, particularly in
aerospace and defense, highly formalized and disciplined program
management controls were instituted on projects related to new
technologies and weapons systems that involved significant
resources and risk. These systems typically involved between tens
of millions to tens of billions of U.S. dollars. As such, structured
management systems were put into place in order to ensure that
adequate control was exercised to achieve effective management
of existing resources and to safeguard the expenditure of the
public money in the government’s oversight role.

In commercial industries, given the plethora of “best of breed”
solutions tied to business sub-cultures, there developed a need to
integrate information both vertically and horizontally across the
enterprise from disparate systems. This synthesis was used to
anticipate corporate performance, particularly in reaction to the
widespread practice in the 1980’s of project sub-optimization at
the expense of the entire enterprise.

In recent years, beginning with the near-universal acceptance of
scalable technologies based on the 32-bit flat address space,
notional concepts of portfolio management and distributed
management across the enterprise utilizing existing information
resources has become a reality. In the early 1990’s, the focus was
on the individual project, usually organized in an hierarchical
model based on its strategic importance, cost or risk to the
enterprise. EPM now has come to mean the ability to manage all
projects across the enterprise and to integrate previously stove-
piped, organizationally-based metrics into an integrated system.
The system allows for the conversion of raw data into information
that allows managers to aggregate that information at the
appropriate organizational level in real time.

The reason for the demand of this type of organized information
is obvious: an organization can only apply a finite level of
resources to its projects. Projects have always tended to compete
for money or personnel. The competition for these resources often
resolved themselves through “politics”, in which the force of
personality of the individual project manager played a role or for
some other anecdotal reason, created a situation in which the
decisions were made and the ramifications were only vaguely
understood. For example, in matrix organizations, personnel
resources are applied to projects in such a way that individual

assets and skills must be shared. Unless all of the entities within
the organization that rely upon such expertise are identified and
included in our system, we will continue to make decisions ad
hoc without understanding the impact until the risk from such a
decision has manifested itself. This is oftentimes called portfolio
management as opposed to individual project management. The
information in the latter systems must roll-up in a meaningful way
for the information contained in the former to be valid and of any
value to the organization. Thus, the terminology EPM is the more
appropriate to this vision.

In order to facilitate EPM, an organization, regardless of its size,
must establish what has often been called in IT Governance
parlance, a project management system. This system is
constructed apart from and prior to, choosing the specific
technological solutions. This system consists of a set of processes,
methods and procedures that must first be established as a best
business process, as if technological resources would otherwise
not be available. Typically, these systems will be based on a
standard model such as the PMBOK, PRINCE2 and, in earned
value-focused organizations, the ANSI 748 guidance. Smaller
companies and organizations may tend to develop a proprietary
discipline based on a scaled version of these principles, resources
applied and risk undertaken.

The essentials of this system involve processes that must be in
place in order to ensure adequate management and control. At
this stage, the focus for these processes is still at the individual
project level. These are:
1. Assignment of Work

2. Identification, definition and scheduling of work

3. Allocation of baseline resources and accounting of material and
costs

4. Analysis of performance for cost, schedule and technical
achievement

5. Control and documentation of changes to the baseline and/or scope

Any software application or group of applications, must be able to
facilitate this flow in order to support the business processes
selected by management. Though there will always be variations
in individual implementations, the goal of the systems analyst or
consultant should be the same: Recommending solutions should
be geared to resolutions that meet the overwhelming majority of
organization requirements without modification. This is what I
call the 80% solution. The goal is to provide an integrated solution
that meets the basic requirements for functionality. Complexity
can always be introduced into the solution based on the localized
business environment.

Given this vision, the next step is to come down from the 20,000
foot level and illustrate in detail that functionality in Microsoft
Project. We will then illustrate the manner in which Microsoft
SharePoint fulfills the EPM role as an effective open system,
creating an enterprise-level business intelligence solution. The next
part of this series will address the Microsoft Project Professional
and Project Server portions of this discussion, while SharePoint
will be the main topic of part three.
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